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Introduction
As per the resolution no. 206 issued by the Internal Revenue Service - Ecuador, all
commercial organizations must submit monthly information on sales, purchases,
imports and exports. COA allows you to set up your system so that all the required
information is included in the file that is sent to the tax authorities. Withholding
Certificates allows you to print certificates with the details of your withholdings
from your vendors.
Be sure to understand the resolution 206 and accordingly perform the required setups before
generating the reports. The accuracy of the generated reports depends upon your setups.

Check for current instructions
This information was current as of February 2007. The documentation may be
updated as new information becomes available. Microsoft Dynamics GP online Web
site (http://go.microsoft.com/fwlink/?LinkID=79222) for the most current
documentation.
The introduction is divided into the following sections:
•
•
•
•

What’s in this manual
Symbols and conventions
Resources available from the Help menu
Send us your documentation comments

What’s in this manual
This manual is designed to give you an in-depth understanding of how to use the
features of COA Ecuador, and how it integrates with the Microsoft Dynamics™ GP
system.
To make best use of COA Ecuador, you should be familiar with systemwide
features described in the System User’s Guide, the System Setup Guide, and the
System Administrator’s Guide.
Some features described in the documentation are optional and can be purchased
through your Microsoft Dynamics GP partner.
To view information about the release of Microsoft Dynamics GP that you’re using
and which modules or features you are registered to use, choose Help >> About
Microsoft Dynamics GP.
This manual is divided into the following chapters:
•

Chapter 1, “Setup,” describes how to set up COA for your company. It also
explains how to set up the various parameters that are legally required before
you can calculate the value added taxes.

•

Chapter 2, “Cards,” describes how to assign the tax IDs and enter additional
details for customers and vendors.

•

Chapter 3, “Transactions,” describes how to enter additional information for
documents during transaction entry. This information appears on the tax files to
be sent to the authorities.
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•

Chapter 4, “Reports,” explains how you can generate the monthly reports for
purchasing and sales as required by the tax authorities.

•

Chapter 5, “Withholding certificates,” describes how to set up consecutive
numbers and generate withholding certificates for payables invoices.

Symbols and conventions
For definitions of unfamiliar terms, see the glossary in the manual or refer to the
glossary in Help.
Symbol

Description
The light bulb symbol indicates helpful tips, shortcuts and
suggestions.
The warning symbol indicates situations you should be
especially aware of when completing tasks.

This manual uses the following conventions to refer to sections, navigation and
other information.
Convention

Description

Creating a batch

Italicized type indicates the name of a section or procedure.

File >> Print or File >
Print

The (>>) or (>) symbol indicates a sequence of actions, such as
selecting items from a menu or toolbar, or pressing buttons in
a window. This example directs you to go to the File menu and
choose Print.

TAB

or ENTER

All capital letters indicate a key or a key sequence.

Resources available from the Help menu
The Microsoft Dynamics GP Help menu gives you access to user assistance
resources on your computer, as well as on the Web.

Contents
Opens the Help file for the active Microsoft Dynamics GP component, and displays
the main “contents” topic. To browse a more detailed table of contents, click the
Contents tab above the Help navigation pane. Items in the contents topic and tab
are arranged by module. If the contents for the active component includes an
“Additional Help files” topic, click the links to view separate Help files that
describe additional components.
To find information in Help by using the index or full-text search, click the
appropriate tab above the navigation pane, and type the keyword to find.
To save the link to a topic in the Help, select a topic and then select the Favorites tab.
Click Add.

Index
Opens the Help file for the active Microsoft Dynamics GP component, with the
Index tab active. To find information about a window that’s not currently displayed,
type the name of the window, and click Display.
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About this window
Displays overview information about the current window. To view related topics
and descriptions of the fields, buttons, and menus for the window, choose the
appropriate link in the topic. You also can press F1 to display Help about the current
window.

Lookup
Opens a lookup window, if a window that you are viewing has a lookup window.
For example, if the Checkbook Maintenance window is open, you can choose this
item to open the Checkbooks lookup window.

Show Required Fields
Highlights fields that are required to have entries. Required fields must contain
information before you can save the record and close the window. You can change
the font color and style used to highlight required fields. On the Microsoft
Dynamics GP menu, choose User Preferences, and then choose Display.

Printable Manuals
Displays a list of manuals in Adobe Acrobat .pdf format, which you can print or
view.

Orientation Training
Accesses online tutorials that show you how to complete basic procedures within
Microsoft Dynamics GP. Additional tutorials are available through the
CustomerSource Web site.

What’s New
Provides information about enhancements that were added to Microsoft Dynamics
GP since the last major release.

Microsoft Dynamics GP Online
Opens a Web page that provides links to a variety of Web-based user assistance
resources. Access to some items requires registration for a paid support plan.
Current implementation and upgrade information The most recent
revisions of upgrade and implementation documentation, plus documentation
for service packs and payroll tax updates.
User documentation and resources The most recent user guides, howto articles, and white papers for users.
Developer documentation and resources The most recent
documentation and updated information for developers.
Product support information Information about the Microsoft Dynamics
GP product support plans and options that are available, along with
information about peer support and self-support resources.
Services information Information about Microsoft Dynamics GP support,
training, and consulting services.
Microsoft Dynamics GP Community Access to newsgroups, where you
can ask questions or share your expertise with other Microsoft Dynamics GP
users.
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CustomerSource home page A wide range of resources available to
customers who are registered for a paid support plan. Includes access to
Knowledge Base articles, software downloads, self-support, and much more.

U.S. Payroll Updates
Provides access to tax updates for state and federal tax withholding. When you
select an option, the process to install the updates will begin immediately.
Check with your system administrator before installing tax updates. To be sure that tax
updates are installed correctly, refer to documentation for specific tax updates on the
CustomerSource Web site.

Customer Feedback Options
Provides information about how you can join the Customer Experience
Improvement Program to improve the quality, reliability, and performance of
Microsoft® software and services.

Send us your documentation comments
We welcome comments regarding the usefulness of the Microsoft Dynamics GP
documentation. If you have specific suggestions or find any errors in this manual,
send your comments by e-mail to the following address: bizdoc@microsoft.com.
To send comments about specific topics from within Help, click the Documentation
Feedback link, which is located at the bottom of each Help topic.
Note: By offering any suggestions to Microsoft, you give Microsoft full permission to use
them freely.
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Chapter 1:

Setup
Use this information to set up the various parameters like periods, excise and VAT
rates, voucher types, tax credit details, taxpayer ID, and transaction types as
defined by the tax authorities in resolution 206. These details are used in the
monthly sales and purchasing reports that are sent to the legal authorities.
When you set up COA Ecuador, you can open each setup window and enter
information, or you can use the Setup Checklist window (Microsoft Dynamics GP
menu >> Tools >> Setup >> Setup Checklist) to guide you through the setup
process. See your System Setup Guide (Help >> Contents >> select Setting up the
System) for more information about the Setup Checklist window.
This information is divided into the following sections:
•
•
•
•
•
•
•
•
•
•
•
•

Setting up periods
Setting up bank IDs
Setting up excise details
Setting up VAT rates
Setting up VAT withholding details
Setting up tax credit details
Setting up voucher types
Assigning voucher types to document types
Understanding tax IDs
Assigning details to the tax ID
Setting up the taxpayer ID
Setting up transaction IDs

Setting up periods
You must set up the periods for which to submit the tax declaration.

To set up periods:
1.

Open the Period Setup window.
(Microsoft Dynamics GP menu >> Tools >> Setup >> Company >> COA
Setup >> Period Setup)

2.

Enter the Period ID issued by the tax authority.

3.

Enter a name for the period.

4.

Enter the period start date and end date.

5.

Choose Save to save the period ID you have set up.
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Setting up bank IDs
Use the Bank Setup window to set up bank details that will appear on the monthly
report.

To set up bank IDs:
1.

Open the Bank Setup window.
(Microsoft Dynamics GP menu >> Tools >> Setup >> Company >> COA
Setup >> Bank Setup)

2.

Enter a bank ID and a corresponding name for the bank ID.

3.

Choose Save to save the bank ID you have set up.

Setting up excise details
Use the SCT Setup window to enter the excise rates for various categories as
defined in table 7 of resolution 206.

To set up excise details:
1.

Open the SCT Setup window.
(Microsoft Dynamics GP menu >> Tools >> Setup >> Company >> COA
Setup >> SCT Setup)

2.

Enter the SCT Tax ID.

3.

Enter the name of the category to which the excise detail will apply.

4.

Enter the tax percentage for the category.

5.

Choose Save to save the SCT tax ID you have set up.

Setting up VAT rates
Use the VAT Setup window to set up the VAT details as specified in table 5 of
resolution 206 by the tax authorities.
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To set up VAT rates:
1.

Open the VAT Setup window.
(Microsoft Dynamics GP menu >> Tools >> Setup >> Company >> COA
Setup >> VAT Setup)

2.

Enter a VAT ID and name for the VAT ID.

3.

Enter the tax percentage.

4.

Enter the starting and ending date that the specified VAT ID will be applicable.

5.

Choose Save to save the VAT ID you have set up.

Setting up VAT withholding details
Use the VAT Withholding Setup window to set up the VAT details for withholding
taxes as specified in table 6 of resolution 206.

To set up VAT withholding details:
1.

Open the VAT Withholding Setup window.
(Microsoft Dynamics GP menu >> Tools >> Setup >> Company >> COA
Setup >> VAT Withholding Setup)

2.

Enter a VAT withholding ID and name for the ID.

3.

Enter the tax percentage.

4.

Choose Save to save the VAT withholding ID you have set up.

Setting up tax credit details
Use the Tax Credit Details Setup window to set up tax credit details as specified in
table 4 of resolution 206.
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To set up tax credit details:
1.

Open the Tax Credit Details Setup window.
(Microsoft Dynamics GP menu >> Tools >> Setup >> Company >> COA
Setup >> Tax Credit Setup)

2.

Enter a tax credit ID and the name for the ID.

3.

Choose Save to save the tax credit ID you have set up.

Setting up voucher types
You can set up the voucher types that will be used in posted transactions, as
specified in table 3 of resolution 206.

To set up voucher types:
1.

Open the Voucher Type Setup window.
(Microsoft Dynamics GP menu >> Tools >> Setup >> Company >> COA
Setup >> Voucher Type)

2.

Enter the voucher type ID and the name for the ID.

3.

Choose Save to save the voucher type ID you have set up.

Assigning voucher types to document types
You must assign the voucher type IDs that you have set up to their corresponding
purchasing and sales document types that you use to enter transactions in Microsoft
Dynamics GP. The legal reports will identify transactions by the voucher type ID as
required by the legal authorities.
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To assign voucher types to document types:
1.

Open the Voucher Assignment Setup window.
(Microsoft Dynamics GP menu >> Tools >> Setup >> Company >> COA
Setup >> Voucher Assign Setup)

2.

Enter or select a voucher ID for each sales and purchasing document type that is
listed on the window.

3.

Choose the Doc SOP button to open the Allocate Sales Order Processing
Vouchers window, where you can allocate voucher IDs to Sales Order
Processing documents.
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4.

Choose the Doc POP button to open the Allocate Purchase Order Processing
Vouchers window, where you can allocate voucher IDs to Purchase Order
Processing documents.

5.

Choose Save to save the voucher ID allocation you have entered.

Understanding tax IDs
Tax IDs are identification numbers assigned by the legal authorities to individuals
or businesses that are engaged in commercial activities, based on the nature of the
entity. You can enter the tax ID assigned to your customers and vendors in the
Customer ID and Vendor ID fields of the Customer Maintenance window and the
Vendor Maintenance window, respectively.
Tax IDs are broadly classified as RUC, Identity code, Passport, End user, and Issued
Abroad.
Registro Unico Contribuyente (RUC) This is a fiscal ID that is assigned to
businesses that are authorized to collect taxes on behalf of the tax authorities. For a
fiscal ID, the last three digits must always be 001.
Identity code An identity code is assigned to small businesses. It is a tencharacter code, beginning from the right. If the code contains less that ten
characters, it is filled out with the required number of zeroes to the right.
Passport A passport is assigned to individuals who are not registered under
VAT, and who are below 18 years of age. It is generally a thirteen digit code. If the
code has less than 13 characters, it is filled out with the required number of zeroes to
the right. If it has more than 13 characters, you must enter only the first 13 digits.
End user This code is assigned to the final consumer of a product. For an end
user, the ID is always 9999999999999.
Issued abroad The code for a voucher type issued abroad is always
0000000000001.

Assigning details to the tax ID
Use the RUC Setup window to assign the default tax codes and transaction types for
customers and vendors. These codes are used while entering purchasing and sales
transaction information. You can use the RUC setup window to manually assign
this information to each customer and vendor you have set up. Alternatively you
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can run the Load RUC wizard to automatically load the default codes and
transaction types for all customers and vendors.

To assign details to the tax ID:
1.

Open the RUC Setup window.
(Microsoft Dynamics GP menu >> Tools >> Setup >> Company >> COA
Setup >> RUC)

2.

Select the tax ID type, whether RUC, Identity card, Passport, or End user.

3.

Enter a valid code for the selected tax ID.

4.

Enter the name of the customer or vendor corresponding to the tax code. Enter
the address and telephone number for the customer or vendor.

5.

Enter the default tax credit code for the selected customer or vendor.

6.

Enter the default withholdings code for the selected customer or vendor.

7.

Enter the default purchasing and sales transaction type for the selected
customer or vendor.

8.

Choose Save to save the information entered for the customer or vendor.

9.

Choose Load Documents to open the Load RUC wizard where you can
automatically assign the default tax codes and transaction types to all
customers and vendors. You must have entered all the required fields in the
RUC Setup window.
Running the wizard will delete any tax code and transaction type information that you
previously assigned to customers and vendors.

10. Choose Next in the Load RUC wizard to begin the process. This will assign the
tax codes and transaction types displayed in the RUC Setup window to all the
customers and vendors. This will also identify the customer’s and vendor’s tax
ID type as RUC, Passport, Identification card, End user, or Issued abroad, based
on the values in the customer ID and vendor ID fields. A message is displayed
once this process is completed.
11. Close the Create RUC wizard to return to the RUC Setup window.
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12. Click the Browse buttons at the bottom of the window to view the default
information assigned by the wizard to all customers and vendors. You can
manually change this information if required. Choose Save to save any
information you changed.

Setting up the taxpayer ID
You must set up the taxpayer information as the taxpayer is responsible for
submitting the tax information to the authorities.

To set up the taxpayer ID:
1.

Open the Taxpayer Identification window.
(Microsoft Dynamics GP menu >> Tools >> Setup >> Company >> COA
Setup >> Taxpayer Identification)

2.

Enter the tax ID for the taxpayer in the Taxpayer RUC field.

3.

Enter the name, telephone, fax number, and e-mail address for the tax payer.

Setting up transaction IDs
You must assign transaction IDs to the different transaction types that you enter in
Microsoft Dynamics GP, as specified in table 2 of resolution 206.

To set up transaction IDs:

12

C O A

E C U A DO R

1.

Open the Transaction Setup window.
(Microsoft Dynamics GP menu >> Tools >> Setup >> Company >> COA
Setup >> Transaction)

2.

Enter a transaction ID, and a name to identify the type of transactions that are
associated with the ID.

3.

Choose Save to save the transaction ID you’ve entered.

Chapter 2:

Cards
You must assign the tax ID and enter additional information for customers and
vendors before you can begin entering transactions.
This information is divided into the following sections:
•
•
•

Entering additional information for vendors
Assigning the tax ID to multiple vendors
Assigning the tax ID to multiple customers

Entering additional information for vendors
You can enter the additional information for the vendor that should appear on the
tax reports in the Supplier Information window. If you have not set up the vendor’s
tax ID in the Vendor ID field of the Vendor Maintenance window, you can associate
the tax ID with the vendor ID in this window.

To enter additional information for vendors:
1.

Open the Supplier Information window.
(Cards >> Purchasing >> Supplier Information)
(Cards >> Purchasing >> Vendor >> Select a vendor >> Additional >>
Additional Supplier Information)

2.

Enter or select a Vendor ID. The vendor name and company address defaults
from the Vendor Maintenance window.

3.

The Authorization Number field displays the default number.

4.

The Invoice Serial Number field displays the default number.

5.

Select the Document type for the vendor and enter the tax ID assigned to the
vendor by the legal authorities.

6.

Choose Save to save the details you entered.

Assigning the tax ID to multiple vendors
It is possible that multiple vendors share a single tax ID. In such instances, you can
use the Supplier RUC window to assign a single tax ID to multiple vendors. You can
choose this process if you have not set up the vendor’s tax ID in the Vendor ID field
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of the Vendor Maintenance window. This process will replace the tax ID that you
may have assigned to the vendor manually in the Supplier Information window.

To assign the tax ID to multiple vendors:
1.

Open the Supplier RUC window.
(Cards >> Purchasing >> Supplier RUC)

2.

Select the Document Type, whether Identification Card, Passport, RUC, or End
Consumer.

3.

Enter the tax ID to be assigned to multiple vendors. You must have assigned
this ID to at least one vendor in Microsoft Dynamics GP.

4.

In the scrolling window, select the supplier ID to which to assign the tax ID. You
can select multiple supplier IDs in the scrolling window. The suppliers name is
displayed in the Name column.

5.

Mark the Del. check box for a supplier to remove the supplier ID from the
scrolling window.

6.

Choose Save to assign the tax ID to all the supplier IDs displayed in the
scrolling window.

Assigning the tax ID to multiple customers
It is possible that multiple customers share a single tax ID. In such instances, you
can use the Client RUC window to assign a single tax ID to multiple customers. You
can choose this process for those customers whose tax ID is not set up in the
Customer ID field of the Customer Maintenance window.
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To assign the tax ID to multiple customers:
1.

Open the Client RUC window.
(Cards >> Sales >> Client RUC)

2.

Select the Document Type, whether Identification Card, Passport, RUC, or End
Consumer.

3.

Enter or select the tax ID to be assigned to multiple customers.

4.

In the scrolling window, select the customer ID to which to assign the tax ID.
You can select multiple customer IDs in the scrolling window. The customer’s
name is displayed in the Name column.

5.

Mark the Del. check box for a customer to remove the customer ID from the
scrolling window.

6.

Choose Save to assign the tax ID to all the customer IDs displayed in the
scrolling window.

C O A E C U A D O R
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Chapter 3:

Transactions
Use this information to enter additional details for the vendor or customer during
transaction entry. These details will appear on the tax files that are sent to the
authorities.
This information is divided into the following sections:
•
•

Entering additional details for purchasing transactions
Entering additional details for sales transactions

Entering additional details for purchasing transactions
You can enter additional information for purchasing transactions such as
transaction type, voucher type, VAT, excise and withholding codes etc. These details
will appear on the monthly purchasing tax declaration report that you will file with
the tax authorities.

To enter additional details for purchasing transactions:
1.

Open the Additional Purchase Information window.
(Transactions >> Purchasing >> Additional Purchase Information)
(Transactions >> Purchasing >> Transaction Entry >> Enter required fields >>
Additional >> Additional Purchasing Information)

2.

Enter or select a vendor ID. The window displays the default details for the
vendor.

3.

Enter or select an existing invoice number. If you opened this window from the
Payables Transaction Entry window using the Additional option, then it
displays the details for the invoice number selected in that window. You can
select another invoice number for the same vendor.

C O A E C U A D O R
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The Transaction Type, Voucher Type, Tax Credit, VAT Code and SCT Code
fields display the codes entered for the selected invoice from the RUC setup.
You can change these codes.
4.

Mark the Manual Data Entry check box to manually enter transactions on the
COA file.

5.

Mark the Foreign Transaction option to enter details for an import. The relevant
fields become available where you can enter the details for the import.
The Local Transaction option is the default selection. Be sure to mark correctly whether
the transaction is local or foreign so that the tax reports are updated accurately.

6.

Mark the International Agreement check box for imports that are subject to an
international agreement.

7.

Mark the Right to Return check box for imports that are subject to a VAT refund.

8.

You can enter or change the amounts for the tax base, tariff base, VAT, excise,
and withholding taxes if required. The Total Tax and Total Invoice fields display
the calculated totals based on the values you entered.

9.

Choose Save to save the information you entered for the selected invoice.

Entering additional details for sales transactions
You can enter additional information for sales transactions such as transaction type,
voucher type, VAT, excise and withholding codes etc. These details will appear on
the monthly sales tax declaration report that you will file with the tax authorities.

To enter additional details for sales transactions:
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1.

Open the Additional Sales Information window.
(Transactions >> Sales >> Additional Sales Information)
(Transactions >> Sales >> Transaction Entry >> Enter required fields >>
Additional >> Additional Sales Information)

2.

Enter or select a customer ID. The window displays the default details for the
customer.
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Enter or select an existing invoice number. If you opened this window from the
Receivables Transaction Entry window using the Additional option, then it
displays the details for the invoice number selected in that window. You can
select another invoice number.
The Transaction Type, Voucher Type, Credit Type, VAT Code and SCT Code
fields display the codes entered for the selected invoice from the RUC setup.
You can change these codes.

4.

Mark the Foreign Transaction option to enter details for an export. The relevant
fields become available where you can enter the details for the export.
The Local Transaction option is the default selection. Be sure to mark correctly whether
the transaction is local or foreign so that the tax reports are updated accurately.

5.

Mark the International Agreement check box for exports that are subject to an
international agreement.

6.

Mark the Right to Return check box for exports that are subject to a VAT refund.

7.

You can enter or change the amounts for the tax base, tariff base, VAT, and
excise taxes if required. Enter the FOB amount if you are entering a Foreign
transaction. The Total Tax and Total Invoice fields display the calculated totals
based on the values you entered.

8.

Choose Save to save the information you entered for the selected invoice.

C O A E C U A D O R
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Chapter 4:

Reports
Use this information to generate the monthly reports for sales and purchases as
required by the legal authorities. You must generate four different text files, one
each for the taxpayer information, for local transactions, for invoices affected by
debit or credit notes, and for foreign transactions. You must send these four files to
the legal authorities every month, even if there are no transactions in a particular
month. You can add all the files to the file AXmmaaaa.zip and send them to the
legal authorities.
In each file name, be sure to replace mm with the month, and aaaa with the year for which
you are sending the report. For example, the report for January 2000 should be named
AX012000.zip.
This information is divided into the following sections:
•
•
•
•
•

Generating the taxpayer information report
Generating the local transactions report
Generating the report for invoices affected by debit/credit notes
Generating the report for foreign transactions
Generating the transaction summary report

Generating the taxpayer information report
Use the Taxpayer Information Report window to generate a report with the
taxpayer details that you have entered in Microsoft Dynamics GP. The text file
name for this report is IDmmaaaa.ane, where mm is the month and aaaa is the year
for the report.

To generate the taxpayer information report:
1.

Open the Generate Reports window.
(Reports >> Financial >> Generate Reports)

2.

Select Taxpayer Information in the Report Name field, enter or select the Period
Reported, and choose Process to open the Taxpayer Information Report
window.

3.

Choose Create Report to display the taxpayer information in the scrolling
window.

4.

Choose Create File to save the information displayed to a text file to be
submitted to the legal authorities.
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Generating the local transactions report
You can generate a report for all local transactions entered for a specified period in
the Local Transactions Report window. The text file name for this report is
TLmmaaaa.ane, where mm is the month and aaaa is the year for the report.

To generate the local transactions report:
1.

Open the Generate Reports window.
(Reports >> Financial >> Generate Reports)

2.

Select Local Transactions in the Report Name field, enter or select the Period
Reported, and choose Process to open the Local Transactions Report window.

3.

Choose Create Report to display the details for all the local purchasing and
sales transactions for the selected period in the scrolling window.

4.

Choose Create file to save the information displayed to a text file to be
submitted to the legal authorities.

Generating the report for invoices affected by debit/
credit notes
You can generate a report that displays the details of invoices affected by debit or
credit notes. The text file name for this report is DCmmaaaa.ane, where mm is the
month and aaaa is the year for the report.
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To generate the report for invoices affected by debit or
credit notes:
1.

Open the Generate Reports window.
(Reports >> Financial >> Generate Reports)

2.

Select Invoices affected by ND or NC in the Report Name field, enter or select
the Period Reported, and choose Process to open the Use ND or NC to Report
Transactions window.

3.

Choose Create Report to display the details for all the purchasing and sales
transactions affected by debit or credit notes for the selected period in the
scrolling window.

4.

Choose Create file to save the information displayed to a text file.

Generating the report for foreign transactions
You can generate the report for foreign transactions for the selected period in the
Foreign Transaction Report window. The text file name for this report is
TXmmaaaa.ane, where mm is the month and aaaa is the year for the report.
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To generate the report for foreign transactions:
1.

Open the Generate Reports window.
(Reports >> Financial >> Generate Reports)

2.

Select Foreign Transactions in the Report Name field, enter or select the Period
Reported, and choose Process to open the Foreign Transactions Report window.

3.

Choose Create Report to display the details for all the foreign purchasing and
sales transactions for the selected period in the scrolling window.

4.

Choose Create file to save the information displayed to a text file.

Generating the transaction summary report
The Transaction Summary report is a summary of all local and foreign transactions
for a given period. It is also a certification to be signed by the authorized persons
that the details in the text file accurately reflect the transactions entered for the
selected period for the company.

To generate the transaction summary report:
1.

24

C O A

E C U A DO R

Open the Generate Reports window.
(Reports >> Financial >> Generate Reports)
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2.

Select Generate Transaction Summary in the Report Name field, enter or select
the Period Reported, and choose Process.

3.

Choose to print the report to the screen, to a printer or to a file.
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Chapter 5:

Withholding certificates
Use this information to print the withholding certificates as required by Ecuador
legislation. A withholding certificate must be issued for each payables invoice that
has withholding taxes. The certificate contains the details of the items purchased
and the withholding taxes that were deducted for these purchases.
When you set up Withholding Certificates, you can open each setup window and
enter information, or you can use the Setup Checklist window (Microsoft Dynamics
GP menu >> Tools >> Setup >> Setup Checklist) to guide you through the setup
process. See your System Setup Guide (Help >> Contents >> select Setting up the
System) for more information about the Setup Checklist window.
This information is divided into the following sections:
•
•

Setting up consecutive numbering
Printing withholding certificates

Setting up consecutive numbering
The withholding certificates that you print must be consecutively numbered. You
must specify the starting number for the withholding certificates in the Withholding
Certificate Configuration window. Once you begin printing certificates, this number
will increase by one for each certificate printed.

To set up consecutive numbering:
1.

Open the Withholding Certificate Configuration window.
(Cards >> Purchasing >> Certificate Configuration)

The User field displays the user ID you have logged in as.
2.

Enter the starting number for the withholding certificates. You can enter up to
17 characters. You may also enter a prefix for the number if required. This
number is automatically updated with the next unused number once you begin
generating the withholding certificates. The Last Update field displays the last
date when you generated the withholding certificates.

3.

Choose OK to save your settings and close the window.

Printing withholding certificates
Use the Payables Transaction Inquiry - Document window to generate the
withholding certificates for payables invoices that have withholding taxes. The
certificates are numbered sequentially starting from the number displayed in the
Withholding Certificate Configuration window.
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To print withholding certificates:
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1.

Open the Payables Transaction Inquiry - Document window.
(Inquiry >> Purchasing >> Transaction by Document)

2.

Enter the criteria to view the documents and choose Redisplay to display the
documents as per your selection.

3.

Choose Additional >> Withholding Certificates to print the withholding
certificates for the invoices displayed in the window, that have withholdings
associated with them. A separate report is printed for open and historic
transactions respectively.

4.

Choose OK to close the Payables Transaction Inquiry - Document window after
printing the certificates.

Glossary
Withholding tax
Taxes that are withheld by a customer while
making the payment to a vendor. These taxes
are submitted by the customer to the tax
authorities.

Withholding certificate
A certificate with details of the tax withheld
that is issued with each payables invoice.
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